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Resumen 

Los hongos micorrízicos arbusculares (HMA) son un grupo de hongos que forman 

relaciones simbióticas a través de las raíces con la mayoría de las plantas terrestres. Los 

HMA colonizan las raíces de la planta introduciéndose en sus células donde se realizará 

un intercambio de nutrientes entre la planta y el hongo. Por medio de esta asociación, los 

HMA benefician a la planta al incrementar la absorción de nutrientes, agua y otros 

minerales del suelo, a cambio, el hongo recibe carbohidratos producidos por la planta a 

través de la fotosíntesis. Estos hongos también potencian la tolerancia a estrés abiótico de 

la planta y su resistencia contra patógenos. Debido a sus beneficios agrícolas, es 

importante estudiar estos organismos y sus mecanismos. 

Este estudio investigó el impacto de los hongos micorrícicos arbusculares (HMA) nativos 

en las plantas de Physalis pubescens sometidas a estrés salino. Se evaluó la colonización 

micorrícica en las raíces, la densidad de esporas en la micorrizosfera, se identificaron y 

caracterizaron las esporas de HMA y se midió la actividad antioxidante en la biomasa 

foliar utilizando el método DPPH. Se hipotetizaba que las plantas inoculadas con HMA 

mostrarían una mayor actividad antioxidante. Los resultados mostraron que las plantas de 

P. pubescens pueden formar una simbiosis con HMA, pero esta relación disminuye en 

condiciones de alta salinidad. La densidad de esporas fue moderada y las plantas con 

estrés salino moderado e inoculación con HMA tuvieron menor actividad antioxidante. 

Esto podría ser debido al tiempo limitado para la formación de una simbiosis estable. En 

conclusión, aunque estas plantas pueden establecer una relación simbiótica con los HMA, 

su eficacia disminuye en condiciones de alta salinidad.  

Palabras claves: colonización micorrízica, DPPH, simbiosis, solanácea, microscopía 

 



 
 

 
 

Abstract 

Arbuscular mycorrhizal fungi (AMF) are a group of fungi that form root-mediated 

symbiotic relationships with most terrestrial plants. AMF colonise plant roots by entering 

the plant cells where an exchange of nutrients takes place between the plant and the 

fungus. Through this association, AMF benefit the plant by increasing the plant's uptake 

of nutrients, water and other minerals from the soil, in return, the fungus receives 

carbohydrates produced by the plant through photosynthesis. These fungi also enhance 

the plant's abiotic stress tolerance and resistance against pathogens. Because of their 

agricultural benefits, it is important to study these organisms and their mechanisms. 

This study investigated the impact of native arbuscular mycorrhizal fungi (AMF) on 

Physalis pubescens plants under salt stress. We assessed mycorrhizal colonisation in 

roots, spore density in the mycorrhizosphere, AMF spores were identified and 

characterised, and antioxidant activity was measured in leaf biomass using the DPPH 

method. It was hypothesised that AMF-inoculated plants would show higher antioxidant 

activity. The results showed that P. pubescens plants can form a symbiosis with AMF, but 

this relationship decreases under high salinity conditions. Spore density was moderate 

and plants with moderate salt stress and AMF inoculation had lower antioxidant activity. 

This could be due to the limited time for the formation of a stable symbiosis. In 

conclusion, although these plants can establish a symbiotic relationship with AMF, their 

efficacy decreases under high salinity conditions.  

Keywords: mycorrhizal colonization, DPPH, symbiosis, solanaceae, microscopy 
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Capítulo 1 

Antecedentes 

1.1. Introducción 

El estrés salino representa uno de los factores abióticos más desafiantes para la agricultura 

mundial, esto afecta tanto la fisiología como la productividad de las plantas. Este tipo de 

estrés desencadena la producción excesiva de especies reactivas de oxígeno (conocidas 

por sus siglas en inglés ROS), que causan daños oxidativos significativos en las células 

vegetales al afectar biomoléculas esenciales como proteínas, lípidos y ácidos nucleicos 

(Gil & Tuteja, 2010; Avery, 2011). Sin embargo, las plantas han desarrollado mecanismos 

antioxidantes, tanto enzimáticos como no enzimáticos, que mitigan los efectos negativos 

del estrés oxidativo, al mejorar la capacidad de adaptación a los ambientes adversos

 (Caverzan et al., 2012). 

Los hongos micorrízicos arbusculares (HMA) son asociaciones simbióticas que han 

demostrado ser efectivas en la mejora de la tolerancia de las plantas a diversas 

condiciones de estrés abiótico (Lenoir et al., 2016), incluida la salinidad (Evelin & 

Kapoor, 2013). Los HMA facilitan la absorción de nutrientes y agua, además de potenciar 

la actividad antioxidante (Sun & Shahrajabian, 2023; Moncada et al., 2015; Luna et al., 

2016; Sharma et al., 2024), lo que ayuda a las plantas a mantener un equilibrio 

homeostático frente a los efectos dañinos del estrés salino (Miranda et al., 2012; Yang et 

al., 2024). 

Physalis pubescens, una especie de importancia medicinal y agrícola (Grigolo, 2020), es 

sensible a condiciones de estrés salino (Yildirim et al., 2011), lo que puede comprometer 

tanto su desarrollo como su rendimiento. En este contexto, el presente trabajo de 

investigación busca evaluar la influencia de micorrizas arbusculares nativas del 
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remanente boscoso seco tropical del campus María Auxiliadora, en la actividad 

antioxidante (como indicador de estrés) de Physalis pubescens sometida a condiciones de 

estrés salino, con el fin de explorar estrategias biotecnológicas que puedan optimizar su 

cultivo bajo esta forma de estrés abiótico.  

 

1.2. Problema 

La presión sobre los sistemas agrícolas continúa en constante aumento, debido al 

exponencial crecimiento de la población (FAO, 2023). La necesidad de producir más 

alimentos enfrenta limitaciones considerables debido a la degradación de los suelos o la 

salinización (Stavi et al., 2021; FAO, 2016). Ante este panorama, la agricultura se ve 

obligada a adaptarse mediante el desarrollo de nuevas estrategias como la aplicación de 

biofertilizantes para aliviar el impacto de estas condiciones adversas, con el fin de 

compensar la pérdida de productividad y garantizar la seguridad alimentaria global 

(Singh, 2021). 

La constante búsqueda de nuevos alimentos pone en la mira a Physalis pubescens, especie 

vegetal subutilizada en la región litoral ecuatoriana, punto evidenciado por su falta de 

oferta en el mercado. No obstante, su posible introducción en el sistema agrícola podría 

encontrarse con diferentes obstáculos, siendo uno de ellos la salinidad de los suelos, el 

cual influye de manera negativa la productividad de esta especie (Miranda et al., 2014; 

Çelikli, 2017; Sholehah, 2022). Trabajos de investigación realizados de la conductividad 

eléctrica (CE) en áreas de la cuenca baja del río Guayas, muestran que alrededor del 38.4 

por ciento de las muestras evaluadas presentan niveles de salinidad que varía de ligera 

(2.1 - 4.0 mS/cm) a media (4.1- 8.0 mS/cm) y el 10.4 por ciento de alta (4.1-8 mS/cm) a 

muy alta (8.1 - 16.0 mS/cm) (Cedeño, 2015). 
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Los hongos micorrízicos arbusculares (HMA) se perfilan como una alternativa 

biotecnológica prometedora para mejorar la resiliencia de las plantas ante circunstancias 

desfavorables (Cardona et al., 2017; Marro et al., 2022). Estos hongos establecen una 

simbiosis mutualista con las raíces de las plantas, lo que no solo mejora la absorción de 

nutrientes esenciales, sino que también activa mecanismos de defensa en las plantas, lo 

que aumenta su tolerancia al estrés abiótico (Wang, 2022). Este enfoque no solo favorece 

la sostenibilidad agrícola, sino que también optimiza la producción, contribuyendo a la 

seguridad alimentaria en un contexto de creciente presión ambiental y demográfica. 

1.3. Delimitación 

La toma de muestras de semillas de Physalis pubescens y consorcio de esporas nativas de 

HMA a partir de la micorrizosfera de la planta se efectuó en los meses de mayo a junio 

de 2024. La experimentación tuvo lugar en la Universidad Politécnica Salesiana, campus 

María Auxiliadora Km 19 Vía a la Costa, en Guayaquil. Las coordenadas del muestreo 

son: 2°11'47"S 80°02'37"W; dicha zona es un remanente del bosque seco tropical. 

En cuanto a la ubicación y la temporalidad de la parte experimental se buscaron las 

condiciones idóneas para favorecer el objetivo del estudio. Esta, se desarrolló durante los 

meses de marzo-agosto 2024. Tuvo lugar en los espacios y laboratorios del campus. 

La institución gestionó los recursos para llevar a cabo la investigación como parte del 

proyecto “Caracterización Fitoquímica Mediante Cromatografía Líquida HPLC de 

Especies Representativas al Remanente Boscoso Seco Tropical del Campus María 

Auxiliadora de la Universidad Politécnica Salesiana Sede Guayaquil Fitoquímica”, 

debido a que el presente tema se alinea con los objetivos del proyecto mencionado. El 



4 
 

 
 

aporte fue con el uso de laboratorios, materiales y demás recursos para la fase 

experimental. 

Los resultados que se obtengan dentro de la presente investigación servirán como aporte 

al estudio de la actividad biológica, efecto de la interacción planta-micorriza, en una 

especie vegetal de la familia Solanácea. Este trabajo sentará las bases para el 

establecimiento de un banco de esporas de HMA en la Universidad Politécnica Salesiana 

sede Guayaquil. 

1.4. Pregunta de investigación 

¿Hubo una diferencia en la actividad antioxidante entre plantas de Physalis pubescens 

inoculadas y no inoculadas con HMA en condiciones de salinidad? 

1.5. Objetivos generales y específicos 

1.5.1. Objetivo general 

Evaluar el efecto de las micorrizas arbusculares nativas en Physalis pubescens bajo estrés 

salino. 

1.5.2. Objetivos específicos 

• Determinar la colonización micorrízica en raíces de Physalis pubescens mediante 

la tinción de azul de tripano. 

• Cuantificar la densidad de esporas en la micorrizosfera de Physalis pubescens. 

• Aislar las esporas de micorrizicas arbusculares nativas en la rizosfera de Physalis 

pubescens para su caracterización morfológica  
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• Inocular un consorcio nativo de micorrizas arbusculares en Physalis pubescens y 

evaluar su aporte a la tolerancia contra estrés salino mediante el método 2,2-

difenil-1-picrilhidracilo (DPPH) en biomasa foliar. 

 

1.6. Hipótesis 

Las plantas de Physalis pubescens inoculadas con HMA presentan una mayor actividad 

antioxidante. 
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Capítulo 2 

Fundamentación teórica 

 2.1.   Hongos formadores de micorrizas arbusculares    

Se denomina micorriza a la simbiosis entre un hongo y las raíces de plantas terrestres (van 

der Heijden et al. 2015). En ecosistemas naturales es raro que una planta no posea 

micorrizas en su sistema radicular lo que convierte esta relación en un fenómeno muy 

común (Corwell et al., 2001, Strullu y Strullu, 2007). Existen diferentes tipos de 

asociación micorrízica, de las cuales las más comunes son Ectomicorriza, 

Orquideomicorrizas, Ericomicorrizas y Micorrizas arbusculares (Bagyaraj, 2014). 

El micelio micorrízico brinda a la planta una mayor superficie para la toma de nutrientes, 

lo cual potencia la eficiencia de esta a la hora de alimentarse. Por otro lado, las hifas 

pueden alcanzar sitios inaccesibles para las raíces de la planta, lo cual le permite obtener 

nutrientes más distantes (Finlay, 2004). En esta relación mutualista, ambas partes son 

beneficiadas. La planta recibe más agua, más minerales, en especial N y P, mientras que 

el HMA recibe lípidos junto con azúcares derivados de la fotosíntesis de la planta (van 

der Heijden et al. 2015).           

 La asociación micorrízica más común es del tipo arbuscular, la cual se da en un rango 

del 70-90 % de las plantas terrestres, en varios tipos de suelos y condiciones ambientales 

(Schüβler et al., 2001). En la taxonomía, los HMA pertenecen al filo Glomeromycota 

(Palenzuela et al., 2008). 

En detalle los HMA hacen referencia a su característica distintiva que es la formación del 

¨arbúsculo¨, el cual es una estructura hifal con una forma semejante a la de un árbol en el 

córtex interior de la raíz. Esta estructura cumple como el puente para el intercambio 

bidireccional de nutrientes (Paszkowski, 2006, Garg et al., 2019,)  
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2.2. Establecimiento de la simbiosis entre hongos micorrízicos arbusculares y raíces 

de plantas 

La germinación de una espora en estado de reposo es seguida por la formación de un 

micelio exploratorio corto (Smith, 2008). La secreción de exudados vegetales por parte 

de la raíz del hospedador provoca una ramificación repetitiva de las hifas, lo que 

incrementa la posibilidad de un contacto directo entre los simbiontes (Akiyama et al., 

2005; Besserer et al., 2006). Al mismo tiempo, la raíz percibe los exudados fúngicos, los 

cuales activan la vía común SYM (en inglés common symbiotic signaling pathway) 

(Kosuta et al., 2003; Oldroyd y Downie 2004), desencadenando respuestas celulares y 

transcripcionales (células y núcleos verdes, ver figura 1). El contacto entre la planta y el 

hongo es seguido por la adherencia de un hifopodio a la superficie de la raíz, lo que inicia 

la formación de un agregado citoplasmático extenso (de color amarillo, ver figura 1), 

conocido como aparato de prepenetración (PPA) en la célula epidérmica en contacto y en 

la célula cortical externa subyacente (Genre et al., 2005). La colonización intracelular del 

hongo sigue la ruta de los PPAs desde la epidermis hacia la corteza interna, donde las 

hifas intercelulares pueden desarrollarse a lo largo del eje de la raíz. Luego, el mecanismo 

del PPA se replica en las células corticales internas contactadas, tanto antes de la entrada 

del hongo como, en menor medida, durante la ramificación. Por último, un arbúsculo 

ramificado ocupa la mayor parte del volumen celular, lo cual le permite tener una extensa 

superficie para el intercambio de nutrientes (Pumplin y Harrison, 2009). 
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               Figura 1. Establecimiento de HMA en raíz.

 

Nota. adaptado de Bonfante y Genre, 2010 

 

 2.3. Tolerancia salina en plantas huésped mediada por micorrizas arbusculares  

Cuando se utiliza HMA en Casuarina glauca, la expresión de ciertos genes como 

CgNHXs o CgCLCs puede incrementar la biomasa vegetal, el contenido de K+, la 

compartimentalización de Na+ y Cl- en vacuolas, donde se facilita la resistencia a la 

salinidad (Wang Y. et al., 2023), tras la simbiosis con HMA, la mayor regulación de 

SOS1/NHX7 en las raíces de Robinia pseudoacacia facilita la tolerancia al estrés salino 

promoviendo la expulsión de Na+ desde las raíces (Chen J. et al., 2017). La colonización 

con HMA bajo estrés salino eleva la expresión de los genes SlSOS1 y SlSOS2, esto ha 

permitido una mayor tolerancia en el cultivo de tomate (Liu et al., 2023). En condiciones 

de salinidad, las plantas micorrizadas muestran una mayor expresión de genes como 

OsPRX, Os10g, OsHBP1b y OsNCX en comparación con plantas no micorrizadas, lo que 

incrementa la eliminación de ROS (Zhang B. et al., 2023). Wang et al. (2022) reportaron 
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que la expresión de genes relacionados con la transferencia de iones, la eliminación de 

ROS, el metabolismo de carbohidratos, como HAK5, PIP1-2, MYB46, NAC43, GLP10, 

SKOR, CPER y WRKY19, ha sido potenciado por Rhizophagus irregularis, micorriza 

que aporta a la tolerancia al estrés salino en plantas de C. glauca. 

 

2.4. Rol de los antioxidantes frente al estrés salino en plantas 

2.4.1. Suelos salinos 

La relevancia de la salinidad del suelo para el rendimiento agrícola es considerable (Tester 

y Davenport, 2003), debido a su influencia en la implantación, crecimiento y desarrollo 

de las plantas, generando grandes pérdidas en la productividad (Giri et al., 2003; Mathur 

et al., 2007). Los efectos directos de la sal en el crecimiento vegetal pueden incluir: (a) la 

reducción del potencial osmótico de la solución del suelo, lo que disminuye la cantidad 

de agua disponible para la planta, lo que provoca sequía fisiológica; para mitigar este 

problema, las plantas deben mantener potenciales osmóticos internos más bajos para 

evitar que el agua se desplace desde las raíces hacia el suelo (Feng et al., 2002; Jahromi 

et al., 2008); (b) la toxicidad de niveles excesivos de iones Na+ y Cl-, cuyos efectos 

incluyen la alteración de la estructura de enzimas u otras macromoléculas, el daño a 

organelos celulares, las membranas plasmáticas, y la interrupción de procesos como la 

fotosíntesis, la respiración o la síntesis de proteínas (Juniper y Abbott, 1993; Feng et al., 

2002); (c) el desequilibrio nutricional en la planta, causado por la absorción de nutrientes 

o su transporte hacia la parte aérea, lo que provoca deficiencias de iones (Marschner, 

1995; Adiku et al., 2001). 
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2.4.2. Especies Reactivas de Oxígeno  

En estudios relacionados con el estrés salino, se ha observado que las plantas sometidas 

a este tipo de estrés producen especies reactivas de oxígeno (ROS) (Gill & Tuteja, 2010), 

las cuales pueden causar daño celular significativo. 

Los radicales libres son especies químicas de átomos o moléculas que contienen un 

electrón desapareado, lo que los hace inestables, de corta vida y reactivos (Gill & Tuteja, 

2010). Al reaccionar con otras moléculas, inician una cadena de reacciones que pueden 

causar la disrupción de células vivas. Los radicales libres, pueden donar o aceptar 

electrones únicos, lo que los convierte en reactivos significativos en sistemas biológicos 

(Miller et al., 2010; Chaudhary et al., 2023). 

Estos incluyen tanto radicales como no radicales, siendo los primeros inestables y 

reactivos. Entre los tipos más comunes tipos de ROS se encuentran: 

• Anión superóxido (O2•−): Es el ROS más común, generado por la fuga de 

electrones, y puede producir efectos tóxicos directos e indirectos (Orabi & 

Hussein, 2019). 

• Peróxido de hidrógeno (H2O2): No es un radical, pero actúa como agente 

oxidante que puede atravesar membranas celulares. Participa en la formación del 

radical hidroxilo (OH•), que puede dañar el ADN, estar relacionado con la 

mutación y la carcinogénesis (Lin et al. 2021). 

• Radical hidroxilo (OH•): Es uno de los radicales más reactivos en las células 

vivas, causante de daños al ADN y productos de peroxidación lipídica (Constanza 

& Muñoz, 2012). 
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• Oxígeno singlete (1O2): Aunque no es un radical verdadero, es un oxidante 

reactivo que puede dañar los tejidos vivos, es decir, en reacciones relacionadas 

con la exposición a la radiación ultravioleta (Triantaphylidès et al. 2008). 

 

2.4.3. Antioxidante 

 Las plantas están expuestas a situaciones desfavorables e incluso a condiciones 

ambientales extremas. Dentro de estas condiciones encontramos salinidad, falta de 

nutrientes, contaminación por metales, etc. Cuando existe estrés por salinidad, la planta 

acumula ROS las cuales causan varios daños en la planta. Uno de los mecanismos para 

protegerse contra el estrés salino son los metabolitos antioxidantes que esta misma 

produce y así combatir la oxidación de otros compuestos vitales para la planta u otros 

daños oxidativos. Las moléculas antioxidantes son capaces de reducir o prevenir la 

oxidación de otras moléculas (Orabi et al, 2019). 

Las plantas poseen varios mecanismos para poder tolerar el estrés causado por 

condiciones adversas, estos mecanismos se dividen en enzimáticos y no enzimáticos, 

juntos componen el sistema antioxidante en las plantas (Orabi & Hussein, 2019). 

 

• Enzimático 

El mecanismo de defensa antioxidante enzimático (DAE) comprende un grupo de 

enzimas que protegen las células del organismo (Sies, 1997). Para eliminar ROS se 

requiere una serie de pasos que evitará que una especie reactiva se convierta en otra más 

perjudicial. DAE es considerado como la primera línea de defensa contra el estrés 

oxidativo en plantas (Yu, 1994; Chaudiere & Ferrari-Iliou, 1999). 
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Dentro de este sistema, actúan enzimas como superóxido dismutasa (SOD) (Scandalios, 

1993), catalasa (CAT) (Hertwig et al., 1992), ascorbato peroxidasa (APX) (Orabi et al., 

2010; Hasanuzzaman & Fujita, 2011), glutatión reductasas (GR) (Hossain et al., 2011) 

las cuales se encargan de transformar radicales libres. 

 

• No Enzimático 

Por otro lado, el mecanismo de defensa antioxidante no enzimático (DANE) está 

conformado por   varias moléculas de carácter hidrófobo o hidrófilo. Estas moléculas se 

encargan de secuestrar radicales libres y los estabilizan dándoles un electrón (Larkins, 

1999). 

Antioxidantes no enzimáticos característicos en especies vegetales son el ácido ascórbico 

(Vitamina C) (Noctor & Foyer, 1998), tocoferol (Vitamina E) (Orabi and Abdelhamid, 

2016), glutatión (May et al., 1998), flavonoides (Dai and Mumper, 2010), carotenoides 

(Foyer & Harbinson, 1993) (Rudenko et al., 2023). 

 

2.4.4. Técnica 2,2-difenil-1-picrilhidrazil (DPPH) 

En la mayoría de los ensayos que se basan en la transferencia de electrones, la actividad 

antioxidante se simula al utilizar una sonda con potencial redox adecuado, es decir, los 

antioxidantes reaccionan con una sonda fluorescente o con color (agente oxidante) en 

lugar de interactuar con radicales peroxilo. Las técnicas espectrofotométricas basados en 

la transferencia de electrones (ET) miden la capacidad de un antioxidante para reducir un 

oxidante, lo que resulta en un cambio de color cuando se produce la reducción. La 

magnitud del cambio de color (incremento o disminución de la absorbancia de la sonda a 



13 
 

 
 

una longitud de onda específica) se relaciona con la concentración de antioxidantes en la 

muestra (Bondet et al., 1997). En esencia, estas técnicas basadas en ET incluyen ABTS, 

DPPH, ensayo de oxidación ferrosa con xilenol naranja (FOX), el método de tiocianato 

férrico (FTC), FRAP, PFRAP y CUPRAC (Brand-Williams et al., 1995). 

La técnica DPPH es utilizada para evaluar la actividad antioxidante, debido a su 

simplicidad, rapidez y capacidad de proporcionar resultados cuantificables sobre la 

capacidad de captura de radicales libres de un compuesto o extracto. Esta metodología se 

basa en la capacidad de los antioxidantes para donar un electrón o un átomo de hidrógeno 

al radical DPPH, lo que provoca un cambio de color de púrpura intenso a amarillo pálido, 

que puede ser analizado mediante espectrofotometría a una longitud de onda de 517 nm 

(Sánchez-Moreno, 2002).  

 

Figura 2.  Mecanismo Antioxidativo - DPPH. 

 

Nota. Adaptado de CAMAG, s.f. 
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2.5 Solanácea 

Las solanáceas son una familia, de las más extensas, de plantas dicotiledóneas que 

cuenta con alrededor de 100 géneros y 3000 especies distribuidas en todo el mundo 

(Morris & Taylor. 2017). Esta familia incluye productos alimenticios, especias y 

compuestos farmacológicos utilizados a nivel mundial, reflejando su importancia 

económica (Samuels, 2015). 

 

2.6. Especie vegetal Physalis pubescens 

2.6.1 Taxonomía 

Tabla 1. Taxonomía de la especie vegetal Physalis pubescens 

Taxonomía de Physalis 

pubescens 

Reino Plantae 

Subreino Viridiplantae 

División Tracheophyta 

Subdivision Spermatophytina 

Clase Magnoliopsida 

Orden Solanales 

Familia Solanacea 

Subfamilia Solanoidea 
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Género Physalis 

Especie P.  pubescens 

Nota. Recuperado de Integrated Taxonomic Information System, s.f. 

 

2.6.2. Descripción 

Physalis pubescens es una especie vegetal herbácea, anual, dicotiledónea, arbustiva que 

pertenece a la familia Solanácea (Lorenzi et al. 2006). Tiene varios nombres comunes los 

cuales dependen de su distribución geográfica, sin embargo, su nombre más 

representativo es “Uvilla” (Fischer & Miranda, 2012).  

Figura 3. Especie vegetal Physalis pubescens (Los autores, 2024). 

 

Nota. Los autores (2024) 
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2.6.3. Morfología  

Es una planta pubescente dado que posee tricomas similares a pelos en sus hojas y tallos. 

Llegan a medir 30 a 50 cm de alto. Es muy ramificada, tiene hojas opuestas, son anchas, 

tienen forma ovoide a elíptica de 4 a 8 cm de largo y 2 a 5 cm de ancho. Ápice agudo, 

márgenes aserrados, con dientes espinescentes. Pecíolos de 3 a 8 cm de largo. Su flor es 

solitaria, posee cáliz acampanado de 5 a 10 mm de largo. Su fruto es una balla ovoide de 

1.2 cm de diámetro, color amarillo, a veces morado (Xu, 2017).    

        

Figura 4. Morfología foliar de la especie vegetal Physalis pubescens. 

            

 

Nota. Los autores (2024) 

2.6.4. Hábitat 

Esta solanácea prefiere suelos fértiles, condiciones de humedad, puede tolerar escasez de 

nutrientes. Se encuentra en áreas perturbadas, límites de plantaciones, al pie de carreteras, 

zonas de desechos y planicies. Por lo general crece en agrupaciones, su población 
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predomina en zonas ruderales o perturbadas. En ciertos países se considera como una 

especie invasiva (Xu, Z., 2017).        

 

2.6.5. Distribución 

P. pubescens es una especie nativa de América, incluyendo Estados Unidos, México, 

América Central y gran parte de Sur América (Xu, Z., 2017). 

Figura 5. Especie vegetal Physalis pubescens 

 

Nota. Los autores (2024) 

2.6.6. Etnobotánica de P. pubescens 

Physalis pubescens, es una especie vegetal con un amplio valor etnobotánico debido a 

sus propiedades medicinales, alimenticias y culturales (Zimmer et al., 2019; Cheng et al., 

2022) Tradicionalmente, se ha utilizado para tratar diversas afecciones, como dolores 

posparto, infecciones de la piel y como diurético, gracias a sus altos niveles de 
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antioxidantes y vitamina C que refuerzan el sistema inmunológico (Grigolo et al., 2020). 

Los frutos de Physalis pubescens se consumen principalmente frescos, ya que conservan 

mejor sus compuestos bioactivos, aunque también son utilizados en ensaladas, 

mermeladas y conservas.  

En resumen, Physalis pubescens no solo es una fuente de alimentos saludables, sino que 

también tiene aplicaciones medicinales y artesanales. A pesar de ser menos conocida que 

otras especies del género, su potencial como cultivo alternativo para pequeños 

agricultores y sus múltiples beneficios destacan su importancia en diversas culturas, 

subrayando la necesidad de más estudios sobre sus propiedades y aplicaciones. 
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Capítulo 3 

Materiales y métodos 

 3.1 Materiales 

Para el análisis del impacto de las micorrizas arbusculares frente al estrés salino en P.  

pubescens se utilizaron diversos recursos en cada una de las fases del proceso como la 

recolección de esporas, semillas, los análisis en laboratorio, y extracción de data a partir 

de imágenes. En el anexo 1 puede consultar el listado de materiales que fueron utilizados 

para el adecuado desarrollo del presente estudio. 

Figura 6. Esquema metodológico.  

Nota. Ilustracion creada con BioRender por los autores (2024). 

                



20 
 

 
 

3.2. Diseño experimental 

Para el desarrollo de esta investigación se trabajó con plantas de P. pubescens desde la 

germinación. Cabe recalcar que este experimento solo cubrió hasta la fase vegetativa de 

los individuos.  

Se establecieron seis tratamientos diferentes para evaluar la influencia de las micorrizas 

arbusculares y la salinidad en las plantas. El blanco (T1) consistió en plantas corrientes 

sin inóculo de HMA ni estrés salino. El T2 consistió en plantas inoculadas con HMA 

como control negativo. El T3 consistió en plantas inoculadas con HMA y tratadas con 80 

mM de NaCl, mientras que en el T4 se expusieron las plantas únicamente a 80 mM de 

NaCl, sin la presencia de HMA. El T5 combinó plantas con inóculo de HMA bajo un 

estrés más severo de 180 mM de NaCl, y el T6 incluyó plantas expuestas a 180 mM de 

NaCl sin HMA.  

Todas las plantas fueron alimentadas con una solución nutritiva comercial como base a la 

cual se le añadieron concentraciones de NaCl para los tratamientos bajo estrés salino. La 

solución se mantuvo a un pH de 5.5 a 6.5. Puesto que, fue lo recomendable según el 

fabricante de la solución nutritiva. Cada planta fue regada con 200 ml de solución cada 3 

días, las cantidades de riego y la frecuencia se basaron en el trabajo de Miranda (2012).  

En el caso del grupo que se sometió a estrés salino, se utilizaron 2 concentraciones de 

NaCl: 80 mM y 180 mM. Se eligieron estas concentraciones en base al trabajo de 

Shoenlah (2022).  

Los tratamientos tuvieron una duración de 30 días, desde el trasplante hasta la recolección 

final de datos.   
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3.3. Variables 

3.3.1 Variables dependientes 

• Porcentaje de inhibición antioxidante 

• Densidad de esporas 

• Porcentaje de micorrización 

3.3.2 Variables independientes 

• Concentración de NaCl 

• Consorcio de esporas nativas de HMA 

• Tiempo límite de estudio 

 

3.4. Muestreo 

Se tomaron muestras a partir de P. pubescens silvestres y su suelo, ubicadas en el campus 

María Auxiliadora de la Universidad Politécnica Salesiana, con coordenadas: 2°11'47"S 

80°02'37"W. 
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Figura 7. Zona de muestreo. 

  

Nota. Figura generada con Google Earth por los autores (2024) 

Se recolectarán las raíces más externas de la planta, para su posterior verificación de la 

colonización micorrízica en P. pubescens silvestre. En paralelo se recogerán los frutos 

maduros para la posterior obtención de semillas. Además de una muestra de la 

micorrizosfera para la obtención de esporas que será conservada en refrigeración a 4 °C 

hasta su procesamiento. 

 

3.5. Método de evaluación de colonización por hongos micorrízicos arbusculares  

La tinción histoquímica con azul de tripano se realiza siguiendo el método descrito por 

Phillips y Hayman con algunas modificaciones para raíces de tomate (Ho-Plágaro, et al., 

2020). 
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3.5.1 Corte y lavado de raíces 

Las raíces recolectadas serán lavadas con agua para eliminar cualquier residuo de tierra. 

Se cortaron en tiras de 1 cm (Phillips & Hayman, 1970). 

  Figura 8. Raíces con residuos (A) y raíces luego del lavado (B) 

 

Nota. Los autores (2024) 

3.5.2 Clarificación de las raíces 

Las raíces cortadas se depositaron en cassettes histológicos los cuales fueron colocados 

en un vaso de precipitación con agua destilada, hasta la tinción. En caso de no realizar la 

tinción en el mismo día que son segmentadas las raíces, es conveniente almacenarlas en 

refrigeración a 4°C hasta el día siguiente (Ho-Plágaro, et al., 2020). 

Se preparó un baño maría con una olla de aluminio en una estufa eléctrica. Se trabajó en 

una campana de extracción de gases BIOBASE FHI200(P) puesto que el KOH 10 % y el 

ácido láctico con el que se trabajó producen gases tóxicos al hervir. (Ho-Plágaro, et al., 

2020). 
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Se descartó el agua destilada de las raíces, cubrir con KOH 10 % y colocar el recipiente 

al baño maría, llevado a ebullición, durante 10 minutos.  

Luego se removió el KOH 10 %, se enjuagaron las raíces con agua potable varias veces. 

Una vez retirado el agua de enjuague, se cubrieron las raíces con HCl 1 % durante 3 

minutos a temperatura ambiente.  

 

3.5.3. Tinción de raíces con azul tripano 

Después del tiempo mencionado, se descartó el HCl 1 % sin enjuagar, luego se cubrieron 

las raíces con una solución de azul de tripano 0.05 % durante 10 minutos. Se removió la 

solución de azul de tripano 0.05 % y se cubrieron las raíces con una solución de 

lactoglicerol durante 1 hora para remover el exceso de colorante. Una vez transcurrido el 

tiempo, se procedió a montar las raíces en placas portaobjetos para su observación 

microscópica (Ho-Plágaro, et al., 2020). 

Figura 9. Raíces teñidas con azul tripano (A) y montaje de raíces (B).  

 

Nota. Los autores (2024). 
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Este procedimiento se repite con las raíces obtenidas de los tratamientos establecidos. 

3.6. Examinación y cuantificación de micorrización mediante procedimientos 

morfométricos 

3.6.1. Método de las intersecciones ampliadas de McGonigle (modificado)   

Este es un método mejorado para estimar la colonización micorrízica en una escala de 

medida más objetiva, que también elimina la interpretación subjetiva de si las hifas 

observadas en ausencia de arbúsculos son micorrízicas. Esta metodología implica que la 

presencia de arbúsculos o vesículas siempre supone la presencia de hifas (McGonigle et 

al., 1990). 

Se preparó por duplicado portaobjetos, cada uno de los cuales contiene 10 fragmentos de 

raíz de 1 cm. La visualización y cuantificación se realizó mediante un objetivo de 20x LD 

A-PLAN, un microscopio invertido Carl Zeiss™ Axio Vert.A1, una cámara Axiocam 202 

mono, además se utilizó el software Labscope con la opción “Superposiciones de la 

retícula” con el modo “Cuadrícula”. 
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Figura 10. Cuantificación de micorrización mediante la cuadrícula de Labscope.  

 

Nota. Captura de pantalla del software, los autores (2024). 

Para la cuantificación se tomaron en cuenta 3 intersecciones por raíz. Las intersecciones 

con los fragmentos de raíz se clasifican en función de la presencia o ausencia de 

arbúsculos, vesículas e hifas. Por último, se aplican las fórmulas expuestas por 

McGonigle et al. (1990): 

• Proporción de la longitud de la raíz que contiene arbúsculos 

Colonización arbuscular (AC %) = (Número de intersecciones con 

arbusculares/Número de intersecciones totales) *100 

• Proporción de la longitud de la raíz que contiene vesículas 

Colonización vesicular (VC %) = (Número de intersecciones con 

vesículas/Número de intersecciones totales) *100 
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• Proporción de la longitud de la raíz que contiene hifas 

Colonización hifal (HC %) = (Número de intersecciones con 

hifas/Número de intersecciones totales) *100 

 

3.7. Recolección de semillas de Physalis pubescens  

Una vez que se comprobó la presencia de colonización por HMA en las raíces de la 

especie vegetal silvestre se procedió a recolectar los frutos maduros para la obtención de 

semillas. La madurez del fruto garantiza que las semillas presentan condiciones óptimas 

(Edwards & Sundstrom, 1987; Vidigal et al. 2009). 

A los frutos se les removió la envoltura externa y fueron lavados con agua potable. Luego, 

fueron cortados a la mitad con un bisturí, se retiraron las semillas para luego ser lavadas 

con agua potable con ayuda de un colador con la finalidad de remover excesos de pulpa 

(Tapia, 2019). 
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Figura 11. Lavado de frutos (A), fruto con envoltura (B) y fruto sin envoltura (C)  

 

Nota. Los autores (2024) 

 

Se sumergieron las semillas en un vaso de precipitación con agua para descartar las 

semillas que flotan, esto se debe a que estas semillas presentan un embrión poco 

desarrollado formando una cámara de aire que permite que la semilla flote (Varela & 

Arana, 2011). Por último, las semillas fueron depositadas en un plato bajo el sol para su 

secado. 

 

3.8. Selección de semillas  

Después del secado, las semillas fueron sometidas a un criterio de uniformidad en 

cuestión de color y tamaño de área. 

3.8.1. Primer filtro: Color 

En cuanto al color, se observaron de manera visual las semillas de Physalis pubescens, 

con el fin de ver si estas presentan o no una variación en el color. Mediante la plataforma 

web ArtyClick Colors se comprueba si las semillas presentan códigos Hex 
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similares/cercanos o distintos/lejanos. Se obtienen códigos Hex representativos, luego se 

emplea la función “ALEATORIO” en Microsoft Excel, para elegir al azar el color de 

semilla con el que se trabajara.  

 

Figura 12. Variabilidad de color en semillas de P. pubescens. 

 

Nota. Los autores (2024) 

3.8.2. Segundo Filtro: Área 

Se separaron 50 semillas al azar con las características del color elegido. Las semillas se 

ordenaron en una matriz de 5x10 como se observa en la figura 13, se evitó que estas se 

tocaran entre sí para una mejor visualización, y además se colocó una regla de referencia 

para el posterior análisis. Luego, con una cámara Canon Rebel T6 se procedió a realizar 

un registro fotográfico con las muestras para poder obtener el área de estas mediante el 

software Fiji v.2.14, plataforma para el análisis de imágenes biológicas (Schindelin et al., 

2012). Se siguió los siguientes pasos: Open Fiji> File> Open> Select File> Set Scale> 

Image> Type> 8-bit> Image> Adjust> Threshold> Fill Holes > Convert To Mask> Set 

Measurements > Area> Analyze > Analyze Particle. 

De las 50 semillas se eligieron 30 semillas al azar. Pero previo a aquello se realizó una 

estadística descriptiva (media, desviación estándar, mínimo, máximo, mediana, cuartil 
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25%, cuartil 75%, test de normalidad de Shapiro-Wilk), visualizaciones mediante un 

histograma y diagrama de caja. Esta data permitirá confirmar si las semillas presentan 

áreas similares.  Para el análisis estadístico se empleó el lenguaje Python mediante el IDE 

“PyCharm” en conjunto con las librerías estadísticas: pandas, numpy, matplotlib.pyplot, 

y scipy.stats.  

 

Figura 13. 50 semillas de P. pubescens. 

    

Nota. Los autores (2024) 

3.9. Tamizado húmedo 

Las esporas fueron extraídas del suelo recolectado, teniendo como base el protocolo de 

Tamizado Húmedo propuesto por Gerdemann y Nicolson (1963), que se encuentra 

descrito en la página web del INVAM (West Virginia University, 2016). La metodología 

se modificó para acoplarse a los materiales disponibles en los laboratorios de la 

Universidad Politécnica Salesiana. 



31 
 

 
 

A partir de la muestra de suelo se pesaron 10 g con ayuda de una balanza, al cual se les 

agregó 1 L de agua destilada en un vaso de precipitación. Luego se agitó con ayuda de 

una cuchara hasta homogeneizar la solución. Con el fin de eliminar residuos, la muestra 

se deja pasar a través de un juego de tamices de 425 μm, 250 μm, 125 μm y 75 μm. Se 

hace un lavado constante con agua, pero sin perder el contenido retenido en los tamices. 

Se recolecta el contenido del tamiz de 75 μm en un vaso de precipitación de 50 ml, luego 

este volumen se reparte en tubos Falcon de 15 ml, aforando hasta 1 ml, donde se agregará 

una solución de sacarosa + Tween 80 hasta completar los 10 ml de los tubos.  Los tubos 

pasaron a ser centrifugados a 3000 rpm durante 5 minutos. Se vierten los sobrenadantes 

en varias cajas Petri que luego serán llevadas al estereomicroscopio para iniciar el conteo. 

 

3.10. Conteo de esporas de HMA 

Las cajas Petri fueron llevadas a un estereomicroscopio Zeiss Discovery V8 para su 

observación. Se separaron de los residuos de tierra u otros materiales exógenos. Se utilizó 

una fuente de luz fría CL 6000 LED (D) Zeiss para facilitar el proceso de visualización. 

Con la Axiocam 208 Color (cámara acoplada al estereomicroscopio), el software Zeiss 

Labscope y la opción “Contar”, se realizó la enumeración en vivo.  

Para el conteo, se utilizó el método expuesto por Guerra y Chacón (2012) donde una 

densidad baja corresponde a < 1 esporas por gramo de suelo (E/g.S); una densidad media 

corresponde a 1 a 10 E/g.S y una densidad alta corresponde a > 10 E/g.S. De los 10 g de 

suelo pesados, se observó el número de esporas depositados en las cajas Petri para 

registrar la cantidad.  Repetir el punto 3.8 2 veces más, anotar las cantidades de esporas 

de las cajas Petri. Con estos 3 valores se calculó un promedio, lo que permitió tener 

conocimiento de la cantidad de esporas aproximadas por cada 10 g de suelo. 
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Las esporas utilizadas para este conteo fueron almacenadas en solución Ringer y puestas 

a refrigeración a 4°C (Maitra et al., 2021), para su posterior identificación. Este proceso 

se llevó a cabo con ayuda de jeringas de 1 mm para poder manipular las esporas con 

precisión y ser transportadas a un tubo Eppendorf de 2 ml con la solución. 

 

3.11. Inóculo HMA 

3.11.1. Preparación del antibiótico 

Se añadió 2,4 ml de agua destilada o solución salina provista por el fabricante a la 

ampolleta de Penicilina G benzatínica [1’200000 UI] GA, lo que reconstituye la 

Penicilina a una concentración de 500,000 UI/ml. Luego se transfiere la totalidad del 

volumen de la solución a un vaso de precipitación de 100 ml. Se agregó 1 g de 

Estreptomicina a esta solución y se mezcló con un agitador magnético. Se aforó la 

solución a 100 ml con agua destilada. Se esterilizó la solución por filtración con un disco 

para jeringa con membrana de PTFE con poros de 0,22 µm. Se preparó alícuotas en tubos 

cónicos de 15 ml para solución stock, en microtubos de 1.5 ml para uso inmediato (Mayor 

et al., 2005; Galicia, 2008). 

 

3.11.2. Preparación del inóculo  

Al no contar con un banco de esporas o propágulos previos, se trabajó con esporas 

aisladas. El proceso metodológico para el aislamiento es complicado e implica mayor 

inversión de trabajo y tiempo. Se determinó que los inóculos para este estudio cuenten 

con un rango mínimo de esporas.  
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Del promedio que se obtuvo en el punto 3.9 conteo de esporas se estableció que los 

inóculos estarán conformados de la cantidad aproximada de esporas que provengan de 20 

g de suelo micorrizosférico por inóculo. 

Para la preparación de un inóculo de HMA se trabajó vertiendo los sobrenadantes 

provenientes de 20 g de suelo micorrizosférico que se obtienen del tamizado húmedo, en 

un vaso plástico de 200 ml. Este proceso se repite 14 veces más para un total de 15 

inóculos, valor definido por la cantidad de tratamientos en este estudio. 

 

3.12. Identificación de esporas 

Para la identificación taxonómica de esporas de HMA, se llevó a cabo un registro 

fotográfico a partir del software Zeiss Labscope. Las imágenes capturadas fueron 

comparadas con diversos manuales morfológicos de acceso libre, se complementó este 

análisis con consultas en bases de datos especializadas, como por ejemplo la base de datos 

del INVAM (International Culture Collection of Arbuscular and Vesicular-Arbuscular 

Mycorrhizal Fungi) de la Universidad de Kansas. Este enfoque permitió una 

identificación aproximada al correlacionar características morfológicas clave de las 

esporas, así como las descripciones taxonómicas disponibles en la literatura, manuales 

validados y otras bases datos reconocidas. 

Este paso se realizó con un estereomicroscopio Zeiss Discovery V8 y un microscopio 

Zeiss Primostar 3. 
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3.13. Propagación de Physalis pubescens 

3.13.1. Preparación de sustrato 

El sustrato que se utilizó para la propagación de la especie vegetal seleccionada para este 

estudio consistió en una mezcla de turba y arena, en una proporción 1:1. Se utilizó turba 

la cual brinda el soporte necesario para el desarrollo de las plántulas (Agrosavia, 2019). 

La arena en cambio se utilizó con el fin de aumentar la porosidad del sustrato para mejorar 

la infiltración del agua, además incrementa la aireación de las raíces, así como facilita la 

expansión del HMA en el medio (INVAM, 2024). 

Figura 14. Turba/Arena (A), Esterilización sustrato (B)   

 

Nota. Los autores (2024) 

 

Para la preparación de la mezcla, ambos componentes fueron esterilizados en una estufa 

Memmert a 85 °C durante 30 minutos, para asegurar la inocuidad del sustrato (Wolf et 

al., 1994). Luego se procedió a mezclar la turba junto con la arena en un balde con ayuda 

de una pala hasta lograr una consistencia homogénea.  
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Se guardó el sustrato en porciones separadas en fundas Ziploc y se almacenó a 

temperatura ambiente hasta su uso. 

 

3.13.2. Sembrado semillas 

Para la propagación de Physalis pubescens por medio de las semillas recolectadas y 

seleccionadas, se utilizó un semillero de 128 pocillos, cada pocillo de 6 cm de altura.  

Se humedece los pocillos con el fin de que el sustrato se adhiera y con ayuda de una 

cuchara, se colocó sustrato de turba con arena (1:1) en cada pocillo hasta cubrir un 75 % 

de cada pocillo, 30 pocillos fueron rellenados con el sustrato. Después, se colocó una 

semilla en el centro de cada pocillo y se presionó sin llegar a enterrarlas. 

Finalmente se humedece una última vez la superficie del sustrato, se cubre la bandeja con 

papel plástico para generar un cálido ambiente húmedo mientras que permite el paso de 

luz solar para crear las condiciones perfectas de germinación (de Freitas et al., 2021). Las 

semillas fueron germinadas a temperaturas ambientales que oscilaron en un rango de 21 

°C a 31 °C durante 20 días.  
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Figura 15. Semillero de 128 pocillos (A) y plántulas de Physalis pubescens (B) 

 

Nota. Los autores (2024) 

3.13.3. Trasplante 

Una vez que las plántulas alcanzaron el estadio de planta se procedió al trasplante a los 

recipientes finales. Para ello se utilizaron fundas plásticas perforadas de siembra de 1.2 

L, las cuales fueron rellenadas con el sustrato turba y arena 1:1. Se procedió a realizar 

una cavidad de 8 cm de profundidad en el medio del recipiente.  

Con ayuda de una espátula, se retiraron con cuidado las plantas de cada pocillo del 

semillero y fueron colocadas en el agujero realizado en los recipientes. Una vez que la 

planta se encontraba posicionada en la cavidad se procedió a irrigar con el inóculo de 

HMA, bañando tanto las raíces como las paredes del agujero, esto con el fin de asegurar 

el mayor contacto entre el inóculo y la planta.  

Luego, se rellenaron los espacios vacíos con más sustrato hasta rellenar la cavidad y 

asegurar el soporte de las plantas. Es de carácter menester que este paso sea realizado con 

cautela, se debe evitar que las raíces sean maltratadas a la hora de trasplantar lo cual 

afectaría el desarrollo de la planta. 
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Figura 16. P. pubescens listas para trasplante (A) y trasplante a los recipientes finales 

(B)   

 

                  Nota. Los autores (2024) 

3.14. Preparación de los tratamientos 

Una vez que las plantas fueron trasplantadas a los recipientes, damos inicio a los 

tratamientos. 

En el experimento se establecieron seis tratamientos diferentes para evaluar la influencia 

de las micorrizas arbusculares y la salinidad en las plantas. El blanco consistió en plantas 

corrientes sin inóculo de HMA ni estrés salino, corresponde al tratamiento 1 (T1). El T2 

consistió en plantas inoculadas con HMA como control negativo. El T3 consistió en 

plantas inoculadas con HMA y tratadas con 80 mM de NaCl, mientras que en el T4 se 

expusieron las plantas únicamente a 80 mM de NaCl, sin la presencia de HMA. El T5 

combinó plantas con inóculo de HMA bajo un estrés más severo de 180 mM de NaCl, y 

el T6 incluyó plantas expuestas a 180 mM de NaCl sin HMA.  

Todas las plantas fueron alimentadas con una solución nutritiva comercial como base a la 

cual se le añadieron concentraciones de NaCl para los tratamientos bajo estrés salino. La 
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solución se mantuvo a un pH de 5.5 a 6.5, valor recomendado por el fabricante de la 

solución nutritiva. Cada planta fue regada con 200 ml de solución cada 3 días, las 

cantidades de riego y la frecuencia se basaron en el trabajo de Miranda (2012).  

En el caso del grupo que se sometió a estrés salino, se utilizaron dos concentraciones de 

NaCl: 80 mM y 180 mM. Se eligieron estas concentraciones en base al trabajo de 

Shoenlah (2022).  

Los tratamientos tuvieron una duración de 30 días, desde el trasplante hasta la recolección 

final de datos.   

Figura 17. Riego con los tratamientos establecidos 

 

                               Nota. Los autores (2024) 
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3.15. Medición de parámetros morfológicos 

En el día 30 se tomaron los siguientes datos: altura de planta, área de hojas, 

tamaño/longitud y peso de raíces. 

Para la medición de la altura de las plantas, se utilizó una regla de 30 cm, se tomó como 

inicio la base de la planta. Todos los individuos fueron medidos.  

En cuanto a la medición del área de las hojas se recortan las hojas de la zona media de la 

planta con ayuda de una tijera y se procede a realizar un registro fotográfico. Las medidas 

se tomaron con el software de análisis de imágenes Fiji v.2.14. 

Se tomó el sistema radicular de dos individuos de cada tratamiento de forma aleatoria. 

Las plantas fueron removidas de sus recipientes, con ayuda de un bisturí se removió el 

sistema radicular sin afectar la integridad de las raíces. Estas fueron sacudidas para 

remover todos los excesos de sustrato y luego fueron llevadas a una balanza para ser 

pesadas. Se generó el registro fotográfico, luego se procedió a tomar las mediciones de 

longitud con ayuda del software Fiji v.2.14. 

 

3.16. Preparación del extracto foliar vegetal  

Se secaron suficientes hojas maduras de los diferentes tratamientos por duplicado a 45° 

durante 48h, en una estufa Memmert y se empleó un mortero para la molienda. Con 0.5 

gramos de muestra de cada tratamiento, se preparó una mezcla con 10 ml de metanol 99.8 

% en un baño ultrasonido GNATUS por 20 min; del extracto, se separaron 15 ml, porción 

que se centrifugó a 14000 rpm durante 8 min en un centrífuga mrc LGCEN-307. Luego 

se separó 2 ml del sobrenadante y se centrifugó a 14000 rpm durante 5 minutos en una 

centrifuga Eppendorf MiniSpin (Atanassova et al., 2011). 
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Los extractos se diluyen a diferentes concentraciones: 200 y 500 µL ml-1. 

 

3.17. Medición de la actividad antioxidante por método DPPH 

• Preparamos una solución de DPPH al 0.004 % en metanol al 98.8 % (Pesamos 4 

mg de DPPH, se aforó a 100 ml de metanol en oscuridad), colocamos en un frasco 

cubierto con aluminio, y se mantuvo en refrigeración hasta el momento de uso. 

• En tubos, 1 ml de los extractos a las concentraciones indicadas fueron añadidos a 

4 ml de una solución de DPPH 0.004 %. 

• Se organizaron los tubos en una gradilla y se pusieron en agitación a 200 rpm en 

una incubadora agitadora (marca) durante 45 minutos en completa oscuridad. 

• Se encendió el espectrofotómetro UV-VIS DR6000 HACH, se programó la 

longitud de onda a 517 nm. 

• Enceramos el equipo con metanol al 99.8 %. 

• Medimos la absorbancia del blanco (DPPH + metanol). 

• Medimos las absorbancias de las diferentes muestras a 517 nm. 

El porcentaje de inhibición se calculó con ayuda de la siguiente fórmula: 

I% = [(Absblanco – Absmuestra) / Absblanco] x 100 

Donde Abs representa la absorbancia. 
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Capítulo 4 

Resultados y discusiones 

4.1. Porcentaje de micorrización de Physalis pubescens silvestre 

Se cuantificó el porcentaje de colonización de HMA en raíces del ejemplar silvestre de P. 

pubescens. Con un porcentaje de micorrización total (MT) de 56,6 % el cual se desglosa 

en: 90% de hifa, 48,3 % de vesícula y 31,6 % de arbúsculos tal como se muestra en la 

Figura 18.  

Montana (2018) reportó un 52% de micorrización en Solanum hindsianum; por otro lado, 

los investigadores Songachang & Kayang (2012) demostraron que tres especies del 

género Solanum spp. Presentaron un porcentaje de micorrización total no mayor al 42%. 

Otra especie de la familia solanácea, Nicotiana plumbaginifolia reporto un porcentaje de 

micorrización del 74% (Mandal & De, 2024). Una pariente cercana, Physalis peruviana 

reportó un MT del 68,5% (Ramírez et al., 2019). En comparación con estos valores, el 

MT del ejemplar silvestre del presente estudio cuenta con un valor superior. Sin embargo, 

no se puede afirmar con certeza que Physalis pubescens cuente con una mayor capacidad 

para promover la colonización micorrícica, para ello se debe proyectar en trabajar con un 

mayor volumen de raíces para obtener una mejor estadística a la hora de cuantificar la 

micorrización. Además, la información referente a la micorrización asociada a P. 

pubescens es limitada o nula.  
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Figura 18. Estructuras fúngicas en raíces de Physalis pubescens silvestre; Hifa (A), 

Arbúsculos (B) y Vesículas (C). 

Nota. Los autores, 2024. 

 

Figura 19. Porcentajes de micorrización de Physalis pubescens silvestre 

 

 

 

 

 

 

 

        Nota. Los autores (2024) 

El grupo de plantas inoculadas con HMA nativos presento un porcentaje de MT del 34,2 

%. Con respecto a las estructuras fúngicas observadas se obtuvo un 58,33 % de hifa, 18,33 

% de vesícula y un 11,66 % de arbúsculo.  
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El porcentaje de colonización micorrízica decayó a medida que la concentración de NaCl 

aumento. Se observo una reducción de estructuras fúngicas, en consecuencia, un 

porcentaje menor de micorrización. El tratamiento de mayor concentración de NaCl (180 

mM) no demostró presencia de HMA lo cual sugiere que las concentraciones de extrema 

salinidad interfieren con el potencial colonizador de los HMA nativos. Estos resultados 

concuerdan con el trabajo de Miranda (2012) donde concluyó que concentraciones 

elevadas de NaCl inhiben la micorrización en plantas de P. peruviana. 

Diversos estudios (Estrada et al., 2012; Aroca et al., 2013; Lenoir et al., 2016) reportan el 

impacto de la salinidad en el desarrollo de los HMA. Estos trabajos evidencian la 

disminución de las capacidades de los HMA a la hora de colonizar a sus hospederos y el 

daño fisiológico que esta salinidad causa en las esporas o estructuras fúngicas, donde se 

mencionan bajos porcentajes de germinación en esporas y pobre desarrollo de hifas 

germinativas. Estos hallazgos respaldan los resultados obtenidos en el presente estudio, 

además, esto resalta la necesidad de investigar HMA con tolerancia a altos niveles de 

salinidad en los suelos. 

Figura 20. Estructuras fúngicas en raíces de Physalis pubescens T2; Arbúsculo (A), e 

Hifa (B)  

 

Nota. Los autores (2024) 
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Figura 21. Porcentajes de micorrización de T2 (A) y porcentajes de micorrización de T3 

(B) 

 

 

 

 

Nota. Los autores (2024) 

 

            4.2. Densidad de esporas asociado a la micorrizosfera de P. pubescens 

silvestre 

Se evidenció que por cada 10 gramos de suelo hubo un promedio de 22,67 

esporas. Este valor refleja una densidad media. Una cantidad intrigante si se 

toma en cuenta que el suelo se encontraba en una zona perturbada por 

actividades antropogénicas (sitios de construcción, herbicidas, entre otros). 

Akond (2008) reportó una densidad baja-media (1-2 esporas E/g.S) en 

solanáceas cultivadas en suelos maltratados por la actividad antropogénica en 

Bangladesh. 
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Tabla 2. Densidad de esporas en Physalis pubescens silvestre donde “R” 

corresponde a las réplicas, (E/g.S) corresponde a esporas por 1 gramo de suelo. 

Densidad de esporas en micorrizosfera de Physalis pubescens silvestre 

 Esporas/10 g suelo E/g.S Densidad 

R1 22 2,2 MEDIA 

R2 17 1,7 MEDIA 

R3 29 2,9 MEDIA 

 

Por otro lado, existen estudios que demuestran una alta densidad de esporas de 

HMA asociada a la micorrizosfera de varias especies de solanáceas con valores 

de entre 19,42 a 29,6 E/g.S (Songachang y Kayang, 2008). Otros trabajos (Hage-

Ahmed et al., 2019; Zocco et al., 2008) demuestran que algunos géneros de HMA 

se ven afectados en presencia de herbicidas y fungicidas, inhibiendo el desarrollo 

de hifas o de la espora misma, lo cual lleva a la muerte del propágulo por falta 

de un anfitrión. 

El valor que se obtuvo de E/g.S permitió delimitar la cantidad de esporas que se 

empleó para la elaboración del inóculo de los tratamientos. Serralde (2022) en el 

manual “Multiplicación de hongos formadores de micorrizas arbusculares 

(HFMA) a pequeña escala para producción de plántulas de uchuva” sugiere 

aplicar 70 esporas por plántula. Vale la pena recalcar que en este manual las 

esporas se obtuvieron a partir de plantas trampas, lo que aseguraba una gran 

cantidad de esporas para los inóculos. No obstante, en el contexto del presente 

estudio no se contaba con un banco de esporas o planta trampa, por lo que la 
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única vía de obtención era el aislamiento manual de las esporas asociadas a la 

micorrizosfera de Physalis pubescens silvestre.   

 

4.3. Identificación de esporas de HMA nativas de micorrizosfera de P. pubescens 

Figura 22. Ambispora sp. (A), Acaulospora sp. (D), Septoglomus sp. (E) y 

Diversispora sp. (F) 

 

Nota. Los autores (2024) 

 

Del suelo micorrízosferico asociado a P. pubescens silvestre, se obtuvieron diferentes 

morfotipos de esporas de HMA. De las esporas encontradas se identificaron al menos tres 

generos: Acaulospora sp., Ambispora sp., Septoglomus sp., Diversispora sp. tal como se 

indica en la figura 22. Ciertas esporas no se lograron identificar debido a que a la hora 

de hacer el montado en placa, estas no se aplastaron de manera correcta quedando 
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deforme la muestra, esto dificulto la identificación puesto que las estructuras y 

ornamentaciones no se podían distinguir. 

La identificación se dio a cabo utilizando manuales y catálogos con el fin de comparar las 

características de nuestras esporas con las de cada genero revisado. En caso de 

Acaulospora sp., una de sus características es la capa externa ya que esta es muy flexible 

y forma esa apariencia rugosa lo cual era bastante notorio en algunas esporas encontradas. 

Con respecto a los otros posibles géneros, se hizo una comparativa del color y la forma, 

pero no se podría confirmar, ya que el montado no se realizó de manera correcta como se 

mencionó antes. 

Estos géneros de HMA se han reportado anteriormente en solanáceas (Ramírez et al., 

2019; Taurinanda & Banjarnahor, 2023). Por otro lado, es importante señalar la naturaleza 

cosmopolita de los HMA, donde se puede encontrar las mismas familias en diferentes 

especies vegetales, siendo Glomeraceae, Acaulosporaceae y Gigasporaceae las familias 

más predominantes de acuerdo con los hallazgos de Cofré (2019) donde realiza una 

revisión de la diversidad de HMA en suelos de Sur América. 

La figura 23 aunque no permite identificar el genero de una espora, debido al empleo de 

un estereomicroscopio que no cuenta con magnificaciones superiores, si permite de 

manera global observar diferentes tamaños, colores y formas. Esta variabilidad de 

parámetros permite un primer acercamiento para confirmar que en efecto se tiene 

diferentes géneros de HMA. 

Estos hallazgos nos brindan un pequeño vistazo a la diversidad de HMA nativos en el 

campus María Auxiliadora de la Universidad Politécnica Salesiana. No obstante, el 

muestreo se limitó a una pequeña porción de suelos que han sido intervenidos por 
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actividades antropogénicas, por ello, es necesario realizar un muestreo más amplio para 

determinar la biodiversidad de HMA con mayor exactitud. 

Figura 23. Esporas de HMA observadas con estereomicroscopio Zeiss  

 

Nota: Los autores (2024) 
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4.4. Medición de la actividad antioxidante por método DPPH 

Figura 24. Histograma de la actividad antioxidante en Physalis pubescens   

 

Nota. Los autores (2024) 

Previo al análisis se verifico que las plantas hayan pasado de manera exitosa por un 

proceso de estrés. Aquello se confirmó observando síntomas como clorosis en las hojas 

(ver anexo 8), disminución en el tamaño de las raíces (ver anexo 8), y caída de hojas en 

los tratamientos con NaCl. Además de una marcada mortalidad en el tratamiento con 

NaCl 180 mM (ver anexo 7). 

La actividad antioxidante mediante el ensayo DPPH, se empleó como otro indicador de 

estrés abiótico. Se esperaba que a medida aumentará la concentración de NaCl en las 

plantas, la producción de compuestos antioxidantes también aumentara. La literatura 

menciona que la asociación micorrízica incrementa la producción de antioxidantes 

(Zhang B. et al., 2023), no obstante, al observar la figura 24, se evidencia como el T3 

(tratamiento con NaCl 80 mM + HMA) presenta un menor nivel de inhibición (lo que 

indica baja producción de antioxidantes), 18,63 % [200 µL/ml-1] y 20,82 % [500 µL/ml-
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1], en comparación con el T1 (tratamiento sin estrés salino ni HMA), 19,53 % [200 µL/ml-

1] y 25,72 % [500 µL/ml-1].  

Aunque los valores parecen indicar que las plantas de Physalis pubescens inoculadas con 

HMA no presentan una mayor actividad antioxidante, hay que tomar en cuenta que este 

estudio se trabajó con un consorcio (con valores aleatorios de cada especie de HMA en 

los inóculos) de esporas, por lo que no se puede asegurar cual especie de HMA sería la 

encargada de brindar una mayor capacidad antioxidante a la planta. Además, Gao et al. 

(2023) indica que toma alrededor de tres semanas para iniciar el contacto entre la raíz y 

el HMA. En cambio, una simbiosis estable se empieza a presentar a partir de sexta 

semana. P. pubescens parece no ser la excepción, donde el estudio duró 30 días a partir 

de la inoculación de esporas. Un valor interesante fue el del T2 (tratamiento solo HMA), 

donde a una concentración de 500 µL/ml-1 presentó el mayor porcentaje de inhibición, 

29,09 %, sin estar frente a un estrés salino. Sin embargo, el resultado de este tratamiento 

no se le puede asignar con certeza a la micorrización, sino más bien parece estar ligado 

al hecho de que este fue un tratamiento sin estrés salino. 

En este estudio se omitió para la medición de actividad antioxidante a los tratamientos 

con NaCl 180 mM, debido a que el tratamiento T5 inoculado con HMA, no presentó 

micorrización en sus raíces.  
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Capítulo 5 

5. Conclusiones y recomendaciones 

5.1. Conclusiones 

• Basado en los resultados de micorrización mediante la tinción histoquímica con 

azul de tripano, Physalis pubescens es una especie vegetal capaz de generar 

simbiosis con hongos micorrízicos arbusculares en un porcentaje mayor al 50 %. 

Aunque en condiciones de estrés salino, NaCl 80 mM, este porcentaje es menor 

al 20 % a los 30 días de inoculación. En cambio, en condición de NaCl 180 mM, 

se presentó 0% porcentaje de micorrización. 

• El análisis morfológico de las esporas de HMA asociado a la micorrizosfera de 

Physalis pubescens demostró la presencia de al menos cuatro géneros de HMA 

probables, siendo Acaulospora sp., Ambispora sp., Septoglomus sp., 

Diversispora sp.  

• Los valores de inhibición en la actividad antioxidante resultaron bajos en el 

tratamiento con NaCl 80 mM inoculados con HMA, sin embargo, esta repuesta 

parece estar influenciado por el limitado tiempo que tuvo P. pubescens para 

generar una simbiosis estable con los HMA. 
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5.2. Recomendaciones 

• Se sugiere optar por otras técnicas de microscopía para la visualización-conteo de 

estructuras como las hifas, y arbúsculos. La tinción de las estructuras con WGA 

Alexa Fluor 488, y el empleo de un microscopio de fluorescencia confocal, 

permitirá observar mejor las estructuras que pasan desapercibidas usando un 

microscopio de campo claro. 

• En futuras investigaciones similares, es importante tener tiempos de 

experimentación más largos para poder observar mejor como avanza la 

micorrización en el hospedero. 

• Se sugiere realizar una identificación molecular mediante los genes de ARNr, o el 

gen que codifica a la proteína tubulina beta, para un acercamiento más exacto a la 

diversidad de HMA nativos al campus María Auxiliadora. 

• Se sugiere para investigaciones similares que el inóculo de HMA este compuesto 

por una sola especie para evitar variabilidad en los resultados. Lo que vuelve 

imperativo la necesidad de contar con plantas trampas para poder acceder a un 

mayor numero de esporas de HMA, de la especie que se piense evaluar.  

• Se sugiere el uso de un microscopio DIC para una mejorar visualización de las 

capas de esporas de HMA, lo que permitirá una mejorar identificación.  
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ANEXOS  

Anexo 1. Materiales y equipos 

Equipos Materiales Reactivos 

Centrifuga Tamiz 425  KOH 10% 

Microscopio invertido Tamiz 250 Azul de tripano 

Microscopio campo claro  Tamiz 125 Agua destilada 

Estereomicroscopio Tamiz 75 Sacarosa 

Estufa Cajas Petri Ácido láctico 

Baño de ultrasonido Cassettes histológicos Glicerol 

Espectrofotómetro Placa portaobjeto Tween 80 

Campana de extracción de gases Placa cubreobjeto Metanol 99.8% 

Refrigeradora Jeringas DPPH 

Micropipeta Bisturí Solución Ringer 

Balanza  Tubo Falcon 15 ml  HCl 1% 

  Gradilla   

  Vasos de precipitación   

  Celdas espectrofotómetro   

  Tubos de ensayo   

  Papel aluminio   

 

 

Anexo 2. Obtención de muestras de Physalis pubescens 

 

 



68 
 

 
 

Anexo 3. Secado de semillas de P. pubescens 

 

 

Anexo 4. Reactivos para tamizado húmedo y tinción histoquímica 
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           Anexo 5. Montaje de raíces 

 

          Anexo 6. Trasplante de Physalis pubescens 
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            Anexo 7. Mortalidad tratamiento con 180 mM NaCl 

 

 

           Anexo 8. Indicadores de estrés salino 
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             Anexo 9. Extracto foliar para medición antioxidante 

 

             Anexo 10. Extractos foliares con DPPH para medición antioxidante 

 

           Anexo 11. Equipos de microscopia 
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         Anexo 12. Medición raíz en Fiji 

 

         Anexo 13. Tratamientos antes y después  
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          Anexo 14. Mediciones morfológicas 

Tratamiento Réplica Altura (cm) 

Promedio 

área hoja 

(cm2) 

 Longitud 

de raíces 

(cm) 

 Peso de 

raices (g) 

T1 

R1 20 73,305 17,153 1,85 

R2 22,7 70,284 17,041 1,86 

R3 21,3 80,574     

R4 21 72,192     

R5 17 75,886     

T2 

R1 23 81,643 23,683 2,32 

R2 19,1 77,614     

R3 18,2 83,972     

R4 19 78,945 25,443 2,51 

R5 19,7 84,447     

T3 

R1 13,5 41,61 38,886 1,1 

R2 11,8 36,554     

R3 10,7 28,964     

R4 13,7 39,794     

R5 14,8 46,256 36,289 1,18 

T4 

R1 10,5 32,481 34,558 0,895 

R2         

R3 11,1 35,894     

R4 11 45,388   0,964 

R5 11,2 48,721 32,712   

T5 

R1 4,3 13,762 8,892 0,0568 

R2         

R3         

R4 2,4 13,545 9,327 0,0562 

R5         

T6 

R1         
R2         

R3 4,2 11,235 7,898 0,0539 

R4         

R5 3,4 12,366 7,538 0,0541 

(T1) Planta; (T2) Planta + HMA; (T3) Planta + HMA + 80mM NaCl; (T4) Planta 

+ 80 mM NaCl; (T5) Planta + HMA + 180nM NaCl; (T6) Planta + 180 mM NaCl 

 


